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 About ListBlox

ListBlox Dedicated List Manager

ListBlox is a list maker that enables you to capture, sort, filter, share, organize and search list-based 
information. The type of lists you create depend on your own requirements, and you can create almost 
any kind of list imaginable for example, to-do lists, addresses, inventories, Internet sites, itineraries and 
so on. ListBlox has full OLE (Object Linking and Embedding) functionality so that you can integrate it 
directly into your Windows 95 environment.
ListBlox has many of the features of a spreadsheet or a database application, but you do not need to 
navigate through complicated dialogs and menus to get at the functionality. Nor do you need to specify 
filenames or search through directories to access ListBlox.

You can place a ListBlox directly in a document at the precise location where you need it this could be a 
word processor document or a spreadsheet or any document where you need list support. Alternatively, 
you can place a ListBlox directly on the Windows 95 desktop so that it is readily available at all times.

        ListBlox Features



 ListBlox Features

As well as being fast and easy to use, ListBlox contains a number of advanced features for data input and 
management. 

Templates: ListBlox is delivered with a set of ready-to-go templates that you can use for specific 
applications. They include to-do lists, wine lists, music album lists and diaries. You can modify these 
generic lists to suit your own requirements or you can create your own templates from scratch. Browsing 
around the supplied templates will give you an idea of the range of applications for ListBlox.

Sorting, Filtering and Prioritizing Data: At a single mouse click you can sort your lists in 
ascending or descending order; you can filter lists so that they contain only items that answer your filter 
criteria. Using the traffic light data type, you can color-code the data type in a field and then sort on the 
colors

typically, associating the colors with different priority levels. 
Linking and Embedding: ListBlox lists have full OLE functionality. You can embed or link them 

into documents or other objects simply by dragging the ListBlox icon from ToolBlox and dropping it in 
place

you have the choice of displaying the ListBlox as icons or as the displayed list, and of editing embedded 
ListBlox either in place or in separate windows. You can also place ListBlox directly on the desktop for 
ease of access. ListBlox can also act as containers for other objects such as spreadsheets, NoteBlox 
notes, and CalcBlox calculations. Again, simply drag the object from ToolBlox and drop it into place.

Display Formatting: When you embed a ListBlox in a container document, you can display it in 
its entirety or as an icon. You can also apply different font, style, size and color attributes to ListBlox cells 
and titles.

Data Properties: You can associate different columns with different data types
for example, text, numerical data, pull-down list, traffic light data and so on.

Importing and Exporting Lists: if you have ODBC installed, you can exchange lists between 
ListBlox and any ODBC-compliant application (available with ListBlox Professional only).



 ListBlox Window

For a description of any component, click on that component in the sample window below (a tool button or 
menu, for example). Note that you can use the Blox | View command to specify which components of the 
ListBlox window are displayed at any time.



New

Creates a new ListBlox in the ListBlox window. If you already have a ListBlox open, you are prompted to 
save it as a file.



Open

Opens a ListBlox that you have previously saved as a file. You specify the filename and the folder where 
it is located, and the ListBlox is then displayed in the ListBlox window.



Save

Saves a ListBlox to its current filename and folder.



Template

Use to create a ListBlox with a particular template in place. The Template dialog box presents all existing 
ListBlox templates and you select the one you want by double-clicking on it or by clicking on it and 
choosing OK.



Always on Top

Click this button if you want ListBlox always to appear on top of other windows on your desktop.



Drag List

To embed the current ListBlox into another application or object, press and hold down this button and 
drag to the desired location.



Drag-Link

To create a link to the current ListBlox in another application or object, press and hold down this button 
and drag to the desired location. The button is available only for ListBlox that have been saved as files.



Properties

To view the properties of the currently highlighted column. Column properties include the column caption 
and data type..



Resize Cells

Resizes the cell width or height to take account of the largest entry in a row or column. This is particularly 
useful where a cell contains a long entry.



Resize List

Resizes the ListBlox application window to take account of the size of the list, where possible showing all 
entries in the list.



Insert Column

Inserts a new blank column to the right of the ListBlox. If you select a number of columns before you 
choose this button, then that number of columns is inserted to the left of the first selected column. 



Insert Row

Inserts a new blank row at the bottom of the ListBlox. If you select a number of rows before you choose 
this button, then that number of rows is inserted above the first selected column. 



Apply View

Lists the views you have created on the current ListBlox. You can then select the view you want to apply.



Manage View

Manage views on the current ListBlox you can add new views, delete old views, and apply views.



Reapply Sort and Filter

Reapplies the previously used sort and filter.



Up/Down Sort 

Click on the up or down arrows to sort on this column in ascending or descending order. If you keep 
SHIFT or CTRL pressed as you click on these, you can define the sort on more than one column. 



Show/Hide Action Bar

Click on this button to toggle the display of the action bar on or off.



Show/Hide Filter Display Window

Click on this button to toggle the display of the filter display window this lists the contents of each 
column included in the current filter.



Filtering Arrow

Click on this to choose the entries you want to filter.



ListBlox Cells

Enter data in these cells.



Row Numbers

Each row in a ListBlox is numbered. If you prefer, you can replace the numbers with text labels. First 
make sure that the option Number Rows Sequentially option is turned off (choose Options from the Blox 
menu). Then double-click on the number and enter the label you want.



Column Labels

The labels identify the content of the column.



Action Bar

The Action Bar contains the sort arrows and filtering buttons for each column.



Find Button

Finds occurrences of a specified text string.



Status Bar

The status bar is displayed at the bottom of the ListBlox window. The left part of the status bar displays a 
description of the function of menu items and toolbar buttons as you move the mouse pointer over them. 
The right part of the status bar indicates whether the following keys are currently on or off: CAP (Caps 
Lock key is on), NUM (Num Lock key is on), SCRL (Scroll Lock key is on).

The Status Bar also indicates if the current view is valid or invalid. A view is considered invalid where 
changes have been made to the data since the last view was applied. To rectify this, reapply the view.



Caption Bar

This displays the name of the current ListBlox (or List if you have not yet saved it). The Minimize, 
Maximize, and Close buttons are included at its right-hand side, the control menu button at its left-hand 
side. 

To move the ListBlox window, drag the caption bar. 



Scroll Bar

If the ListBlox window is not large enough to display your entire list, use the scroll bar to scroll to the parts 
not currently displayed. You can scroll by dragging the scroll box, by clicking the scroll arrows, or by 
pressing the PgUp, PgDn, or Arrow keys on your keyboard.



 About OLE

OLE is a mechanism that allows applications to integrate seamlessly. Documents can contain objects of 
many different types, created by different applications, and the objects have associated with them not 
only the data necessary to display them but also the information needed to edit them. The host document 
is the container; the application that created the object is the server.

Linking and Embedding 

Using OLE you can choose to embed or link an object into a container. 

Embedded objects are stored in your document, and can be edited using the tools and controls of their 
applications. You simply double-click on an object to activate and edit it. When you send an embedded 
object to other people, they too can view and edit it.

With linked objects, only the display data is included in the container, together with a pointer to the 
original data. When the original object is updated, so is the linked object. And when you double-click on 
the linked object, the original document is immediately launched ready for editing.

In-place (or Visual) Editing 

You can edit an embedded object either in place or in a separate window. Simply double-click on the 
object to activate it. With in-place editing, you edit the object without leaving the container document. The 
necessary menus and tools temporarily replace or supplement those of the container application. Click 
back on the container and its menus and tools reappear. 

Drag-and-Drop 

Drag-and-drop is a fast and intuitive method of moving objects within and across applications. Point to the 
object, press and hold down the left mouse button while dragging the object into place, then release the 
button. To move data, first select it and then follow the same steps. 

Move an object or selected data Drag-and-drop 

Create a copy of the object or data CTRL+Drag-and-drop 

Create an OLE link to the original CTRL+SHIFT+Drag-and-drop

Icon or Content Display 

You can display OLE objects either with their content visible or as icons. To switch modes, right-click on 
the inactive object; then choose Display Content or Display as Icon from the pop-up menu. When creating 
an object directly from ToolBlox, you can create it in either mode. Objects displayed as icons are 
automatically edited in separate windows; objects with content displayed are automatically edited in 
place.



 About ToolBlox

ToolBlox is your point of access for creating ListBlox. It is a powerful, customizable toolbar that provides 
fast access to AlphaBlox objects and to other frequently-used applications such as Microsoft Word or 
Excel. A distinguishing feature is that not only can you use it to launch applications but you can also 
create objects directly from it with a single action. 

To launch ListBlox or any other application included on ToolBlox, simply click on its icon.
To launch ListBlox with a particular template in place, click the Template icon on ToolBlox. Then 

double-click on the particular template you want to use.
To create an object directly in a container document or on the desktop, drag the object's icon from 

ToolBlox to the desired position. You can then activate and work with the object by double-clicking on it. 
You can drag the object as an icon or as an in-place object. The default is set in the ToolBlox preferences, 
but there are also keyboard shortcuts. To create an in-place object, press CTRL while dragging the object 
into position; to create an iconized object, press SHIFT instead. 

To add an application to ToolBlox, use Explorer to locate the executable file (WINWORD.EXE for 
example), and drag it into position on ToolBlox. AlphaBlox objects are automatically added to ToolBlox 
when you install them. 

To change ToolBlox preferences, click on the Preferences icon. Then use the Preferences options 
to change attributes such as the size and layout of icons and whether objects are embedded by default as 
icons or as in-place objects. 

When ToolBlox is the active task, you can switch between its normal size and a captionized version by 
pressing ESC.



 About AlphaBlox

ListBlox is one of a suite of components from AlphaBlox Corporation which gives you quick and easy 
access to frequently-used items such as notes, calculations, and lists. Many other components are 
already available or are under development. 

Making full use of OLE functionality, all components integrate seamlessly with each other, with the 
desktop, and with other OLE-compliant applications they can be combined in whatever way suits your 
needs, and are available wherever and whenever required. 

All AlphaBlox tools are designed to be simple, quick, easy, adaptable, compact and affordable. A 
consistent interface style across the components, and the use of common tools for common tasks, 
contributes to more intuitive interaction with the tools.



 Launching ListBlox from ToolBlox

To launch ListBlox from ToolBlox, click on the ListBlox icon.
To launch ListBlox with a particular template in place, click the Template icon on ToolBlox, and 

then double-click on the template you want. 
To embed a ListBlox object directly from ToolBlox, drag the ListBlox icon into position on the 

desktop or in a container document.



 Creating a ListBlox
There are a number of ways in which you can start ListBlox. 

Drag ListBlox from ToolBlox onto the Windows 95 Desktop. It is displayed there as a Scrap icon. 
Double-click on the Scrap icon to activate ListBlox.

You can start a new ListBlox by clicking on ListBlox in the ToolBlox
you can subsequently save the ListBlox with a filename.

Embed ListBlox within a container application
drag ListBlox from ToolBlox into the container. 

Right-click on the Windows 95 Desktop, then choose New from the menu, and choose AlphaBlox 
ListBlox Document.

Entering ListBlox Data

1 By default, there are 3 rows and 3 columns in a list. To add new columns, click on the Add Column 
button. (If there is a file called Default Template in the Template folder, this is loaded instead.)

2 For each column, double click on the column heading cell and enter its title.

3 Specify the data type for each column by clicking on its title, and then right-click to view the pop-up 
menu. Choose Properties from this, and then set the data type.

4 Now that you have set up the list structure, you can begin to enter data into the cells. If you need to 
add new rows as you progress, click on the Add Rows button.

5 When you have finished creating the ListBlox, click the Close button to close it.

6 You can now double-click on the Scrap icon at any time to read or edit the note. 

7 You can give the Scrap icon a more meaningful name simply by clicking on the current name and 
then typing the new one.



 Defining Column Properties
1 Select the column whose properties you want to define.

2 Click on the Properties icon. (Alternatively, choose Data | Properties from the Blox menu.)

3 You are now presented with the Column Properties Dialog Box and you can proceed to define the 
properties for the column.



 Defining Row Properties
The only row property that you can define is the row label.

1 Select the row whose label you want to define.

2 Click on the Properties icon. (Alternatively, choose Data | Properties from the Blox menu.)

3 Enter the label you want to give the row.



 Column Properties Dialog Box

Caption Enter the caption or label you want to 
appear at the top of the column.

Data Type Select the data type for the column. 

Horizontal 
Justification

You can align the entry on the left, in the 
centre or on the right of the cell.

Vertical Justification You can align the entry on the top, bottom 
or middle of the cell.

More / Less Click here to open or close the lower part 
of the dialog box.

Display 24 hr clock Time and Data/Time data types only
displays the time in 24-hour clock format. 

Dynamic Creation Pulldown data type only click on this if you 
want to be able to add new entries to the 
pull down list

Show Long Dates Date data type only displays dates in long 
format.



 Data Types
You can specify the kind of data that you want to place in ListBlox cells. Select a column (double-click on 
the column heading cell), right-click to view the pop-up menu, and then choose Properties. 

Number Column accepts numeric data (whole numbers only).

Yes / No Column entries default to No. Double-click to change to 
Yes (or press ENTER when it is the active cell). Double-
click again to change back to No.

Traffic Light Column accepts color-coded data red, yellow or green. 
You could associate different values with the three colors
for example, urgent to-do’s could be marked red. 

Default is green. Double-click the cell to cycle through 
the colors.

Decimal Column accepts numeric data. 

Date Column accepts only date entries. The format is 
controlled by the Regional Settings in the Windows 95 
Control Panel.

Text Column accepts any text.

Pull Down Column accepts data selected from a pull down list. The 
pull down list contains all unique entries already made 
for this column. This can save you repetitive typing 
where you want to enter the same data in many rows.

OLE Item Column accepts as entries OLE objects that have been 
dragged and dropped into cells. Objects can be linked or 
embedded.

Time Column accepts only time entries. The format is 
controlled by the Regional Settings in the Windows 95 
Control Panel.

Date / Time Column accepts only date/time entries. The format is 
controlled by the Regional Settings in the Windows 95 
Control Panel.

Note that some data types have particular properties that are accessible by clicking on More for example, 
for Time and Date data types, you can specify that you want to use a 24-hour clock.



 Using Templates

A template is a master ListBlox that you can use again and again, changing only the data. A number of 
templates are supplied with ListBlox, and you can also create your own. 

Creating Your Own Templates

Accessing Templates



 Creating Your Own Templates

1 Create a new ListBlox, specifying the number of columns you want, their heading labels, and any 
other features you want to set including font information.

2 Choose the File | Save As Template command.
3 In the Save As dialog box, enter a name for the template and choose the Save button. This saves 
any entries you have made in the ListBlox, and also the ListBlox properties and any font and color 
attributes, as a template for future ListBlox. (In most cases it is better to save the ListBlox as a template 
without any data in it.)

4 You can now use the Template button on the ToolBlox toolbar to open your template and use it as 
the basis for a new ListBlox. If you save a template with the name Default Template, it is 
automatically loaded when you are creating a new ListBlox.



 Accessing Templates

There are three ways in which you can access templates including the supplied templates and those you 
have created yourself.

Choose the Template button from ToolBlox.
Choose the Template button from the ListBlox toolbar.
Choose Apply Template from the ListBlox File menu

In each case you are offered a list of templates from which to choose. (If you choose Template from 
ToolBlox, the list of templates also includes templates developed within other AlphaBlox applications.)



 Embedding a ListBlox in a Document

1 Open the document you want to annotate for example, this could be a Microsoft Word or an Excel 
document.

2 From ToolBlox, drag ListBlox into position in the document.
3 Double-click on the ListBlox to activate it.

If the ListBlox is displayed as an icon, it opens in a separate window and you enter your data 
there. Click the Close button when finished.

If the ListBlox is displayed with its content visible, you edit it in place. For example, when you 
activate a ListBlox that is included in Microsoft Word, the Word menus and tools are replaced or 
supplemented with those you need to edit your ListBlox. When you are finished, click back on the Word 
document and the Word menus and tools reappear.

4 To switch between displaying the ListBlox as an icon or as content, select the ListBlox, and then 
choose ListBlox Object | Convert from the container application’s Edit menu and check the Display 
as Icon checkbox.



 Embedding or Linking an Existing ListBlox

Embedding

To embed an existing ListBlox into a document or object, click on the Drag List button on the ListBlox 
toolbar and drag to the document or object you want to annotate. You can then double-click on the 
ListBlox to activate and edit it.

Linking

To create a link in another document or object to an existing ListBlox, click on the Drag-Link List button 
and drag into place. Note that you must save the ListBlox as a file before you can do this. Whenever the 
original ListBlox is updated, the linked ListBlox is updated also. And you can edit the original ListBlox by 
double-clicking on the linked ListBlox.

Embedding and Linking Data from ListBlox Cells

You can also embed or link data from ListBlox cells. To embed, select the cell(s) you want, and drag them 
into place in the container document (for example, another ListBlox). The cursor changes to the Drag 
cursor.

To link, hold down CTRL and SHIFT as you drag. 



 Embedding an Object in a ListBlox

For example, to embed a Microsoft Word document in a ListBlox:

1 Create or open the ListBlox.

2 From ToolBlox, drag Word into the ListBlox. Or use the Insert New Object command on the ListBlox 
Edit menu. (Note that the data type for the column must be OLE Item.)

3 Double-click on the document to activate it.

4 Enter your data and click on the Close button when finished.



 Switching Between Icon and Content Display

You can display OLE objects either as icons or with their content displayed. To switch modes, right-click 
on the inactive object; then choose Display Content or Display as Icon from the pop-up menu. 
Alternatively, use the Object | Convert command on the container application's Edit menu.

When creating an object directly from ToolBlox, you can create it in either mode. 

Objects displayed as icons are automatically edited in separate windows; objects with content displayed 
are automatically edited in place.



 Tracking ListBlox

If you have a ListBlox embedded in a document or other object, you can create a shortcut to it anywhere 
on your system and use it for quick access to the ListBlox and its container.

To create a shortcut on the desktop, follow these steps:

1 Right-click on the ListBlox and choose Copy from the pop-up menu.

2 Right-click on the desktop and choose Paste Shortcut from the shortcut menu. A shortcut icon is 
created with a link to the ListBlox.

3 Close the container document.

4 You can now double-click on the shortcut icon whenever you wish to view the ListBlox again. The 
container document is immediately opened at the point where the ListBlox is located. 



 Formatting ListBlox

The Options command on the Blox menu enables you to change certain attributes of your ListBlox, such 
as the font style and size of cells.

Choosing the command displays the Options dialog box where you specify the settings you want to use.



 Printing ListBlox

Use the File | Print command to print the current ListBlox. You can choose to print it to the default printer, 
to any other printer set up on your system, or to a file. You can also specify which pages to print and the 
number of copies required.

Use the File | Print Preview command to see how the ListBlox will look when printed.

Use the File | Print Setup command to change certain print options such as paper size and orientation, 
the printer to use, and the properties of that printer.



 Mailing ListBlox

Use the File | Send command to mail a ListBlox to other people via the electronic mail component of 
Windows 95. The ListBlox and any embedded objects are sent to the specified receivers.



 Saving ListBlox as Files

When you create a ListBlox that is not embedded on the Desktop or attached to another 
document or object, you can save it as a file for future access. Use the File | Save As command. 

When you subsequently edit the file, you can save your changes using the File | Save command 
or the Save button on the toolbar.

When you want to save an embedded or linked ListBlox to a file, use the File | Save Copy As 
command. This saves a copy of the ListBlox to a specified file.

To open a ListBlox you have previously saved to file, use the File | Open command or the Open 
button on the toolbar.



 File Menu

New Creates a new ListBlox in the ListBlox window. You are 
prompted to save the current ListBlox if you have made 
changes to it that you have not already saved.

Open Opens an existing ListBlox file. In the Open dialog, you 
specify the name of the file and its location. Then click 
Open to open it.

Save Saves the current ListBlox to its current filename and folder.

Save As Saves the current ListBlox under a specified name. In the 
Save As dialog box, you specify a name for the file and a 
location. Then click Save to save it.

Apply 
Template

Creates a new ListBlox with a particular template in place. 
When the Template dialog box appears, select a template 
and then click OK to display it in the ListBlox window.

Save As 
Template

Saves the current ListBlox as a template for future reuse. In 
the Save As dialog box, enter a name for the template and 
then click the Save button.

Import 
List

Imports a list from another application this is available only 
if you have installed ODBC.

Export 
List

Exports a list to another application this is available only if 
you have installed ODBC. By default the table takes its 
name from the ListBlox name

Export 
List As

Exports a list to another application this is available only if 
you have installed ODBC. You are offered the opportunity to 
save the destination table by any name you want.

Print Prints the current ListBlox. You can choose to print it to the 
default printer, to any other printer set up on your system, or 
to a file. You can also specify which pages to print and the 
number of copies required.

Print 
Preview

Displays the ListBlox as it will appear when printed.

Print 
Setup

Use to change certain print options such as paper size and 
orientation, the printer to use, and the properties of that 
printer.)

Send Sends a ListBlox to other people via the electronic mail 
component of Windows 95.

1, 2, 3, 4 Reopens the most-recently closed ListBlox files. 

Exit Exits ListBlox. 



 Edit Menu

Insert Row(s) Inserts new row(s) into the ListBlox.

Insert 
Column(s)

Inserts new column(s) into the ListBlox.

Undo Reverses your most recent editing action. 

Clear Clears the contents of the currently highlighted cells.

Cut Deletes selected data, placing it on the clipboard.

Copy Copies selected data to the clipboard.

Paste Inserts the clipboard contents into your ListBlox. 

Paste Link Inserts the clipboard contents into your ListBlox, and 
creates a link between the data in the ListBlox and the 
source data.

Find Finds occurrences of a specified text string. See the Find 
Dialog Box.

Delete Deletes selected data, without placing it on the clipboard.

Insert New 
Object

Inserts a new or existing object into a ListBlox. You can 
insert the object with its content visible or as an icon. You 
can also choose either to embed the object or to create a 
link to an existing file. See the Insert New Object Dialog 
Box. Note, however, that only columns whose data type 
has been defined as OLE item can accept OLE objects.

Links Lists any OLE links included in the current ListBlox and 
enables you to edit them.

Object This command becomes available when you click on an 
object in a ListBlox. The name of the command differs 
depending on the type of object selected for example, 
Microsoft Excel Worksheet Object, CalcBlox Object, 
NoteBlox Object.

Choosing the command displays the Object submenu.
Object | Open Opens the selected object in a separate window, ready for 

editing.

Object | Edit Activates a selected object ready for in-place editing. The 
menus and tools required are added to the ListBlox 
menubar and toolbar.

Object | 
Convert

Enables you to convert a selected object to a different 
object type (where relevant), and also to switch between 
displaying the object as an icon or as content.

 Blox Menu

View Displays a submenu from which you can choose which 
components of the ListBlox window are displayed tool 
bar, dialog bar and caption bar).You can also toggle the 
filter display window and you can access the Toolbar 
options. 

Options Allows you to set ListBlox attributes see Options Dialog 
Box.

Data Gives you access to the Data submenu.

Data | Sort Displays the Sort dialog box where you can specify sort 
options.



Data | Sort 
Ascending

Sorts the selected columns in ascending order.

Data | Sort 
Descending

Sorts the selected columns in descending order.

Data | Collapse Collapses, that is, hides the selected row or column. 

Data | 
UnCollapse All

Restores the display of rows or columns you have 
collapsed.

Data | Delete Deletes the selected rows or columns.

Data | 
Properties

Defines data properties for the selected column. See 
Defining Column Properties

Data | Reapply 
Last Sort and 
Filter

Redisplays a list in its correct sort order after you have 
made some change to it for example, after you have 
added extra rows; it also refilters any data that has been 
added.

Data | Manage 
Views

Displays a list of the data views you have previously 
created. You can create new views, you can apply a 
particular view or you can delete an old view.

Resize List Resizes the ListBlox application window to take account 
of the size of the list, where possible showing all entries 
in the list.

Resize Cells Resizes the cell width or height to take account of the 
largest entry in a row or column. This is particularly 
useful where a cell contains a long entry.



 Help Menu

ListBlox Help 
Topics

Opens the ListBlox online help window.

About 
ListBlox

Displays ListBlox version and copyright details.



 Template Dialog Box

The Template dialog box lists all available ListBlox templates and enables you to create a new ListBlox 
with a selected Template in place. 

Simply double-click on the template you want, or select it and click OK. 

Three buttons are included for changing the way the templates are displayed in the dialog box. The three 
available views are: Icons, List, and Details. When you choose the Details option, full details of each 
template are displayed (name, size, type, and date and time last modified).



 Save As Template Dialog Box

Use the File | Save As Template command to save a ListBlox as a template for future ListBlox. The Save 
As Template dialog box presents the following options:

Save In
Identifies the current folder. The templates currently in that folder are listed in the box below. 

To view how the current folder fits in the hierarchy of folders on your computer, click the down arrow. To 
open one of those folders, simply click on it its contents are then shown in the list below.

Double-clicking on an existing file name in the list saves the template to that file, overwriting the current 
contents of the file.    

File Name
Use to specify a name for the template you want to save. You can specify a full path for the file if you 
wish. If you have selected a file in the list above, its name is automatically entered here.

Save as Type
Specifies the type of file you are saving. ListBlox Template (*.ltx) is the default option. 

Toolbar
The following tool buttons appear at the top of the dialog box:

Up One Level: Opens the folder one level higher than the current one.

Create New Folder: Creates a new folder in the current one.

List: Lists files and folders with their icons and names only.

Details: Lists files and folders with their icon, name, file size, file type, and date last modified.

Save button
Click to save the template to the specified filename and location. If you specify the name of an existing 
file, the current contents of that file will be overwritten. 

Cancel button
Click to close the dialog box without saving the template.



 Options Dialog Box

Use the Blox | Options command to change ListBlox attributes. The Options dialog box presents the 
following options:

Autosize Cells Ensures that each cell expands automatically so that 
its contents are visible.

Autosize List When ListBlox is displayed in a reduced window, this 
option causes the window to expand so that as many 
as possible of the entries are visible.

Show Action 
Bar

Displays the Action Bar sort arrows, filtering and find 
buttons for each column.

Number Rows 
Sequentially

Row numbers begin at 1 and increment by 1, even 
after sorting or filtering.

Auto Wrap Text Text wraps automatically onto the next line in a cell.

Prompt for 
Summary 
Information

When you save a ListBlox, you are prompted to enter 
summary information on it this includes details of its 
title, author and comments.

Title Font Choose the font and other text display characteristics 
you want for column titles.

Cell Font Choose the font and other text display characteristics 
you want for cell entries.

Filter Window 
Font

Choose the font and other text display characteristics 
you want for the Filter Window.

Set Default Choose Set Default to set the current range of options 
as the default.



 Control Menu

Restore Returns the ListBlox window to its size and position 
before you chose the Maximize or Minimize command.

Move Enables you to move the ListBlox window using the 
arrow keys. Choosing the command displays a four-
headed arrow, and you simply press the arrow keys on 
your keyboard to move the window around the screen. 
Press ENTER when finished.

Size Enables you to size the ListBlox window using the arrow 
keys. Choosing the command displays a four-headed 
arrow. First press the arrow key (up, down, left, or right) 
that corresponds to the border you want to move; then 
press the appropriate arrow keys to move that border in 
the desired direction. Press ENTER when finished.

Maximize Enlarges the ListBlox window to fill the entire screen.

Minimize Reduces the ListBlox window to an icon on the taskbar.

Close Exits ListBlox.



 Open Dialog Box

Use the File | Open command to open an existing ListBlox. The Open dialog box presents the following 
options:

Look In
Identifies the current folder. The contents of that folder are listed in the box below.

To view how the current folder fits in the hierarchy of folders on your computer, click the down arrow. To 
open one of those folders, simply click on it its contents are then shown in the list below.

To open one of the files or folders listed, double-click on it. 

File Name
Use to specify the name of the file you want to open this can include the full path for the file. You can 
include * as a wildcard to filter the files displayed in the list above. If you select a file in this list, its name is 
automatically entered here.

File of Type
Specifies the type of file to be listed in the Open dialog box. ListBlox Document (*.lbx) indicates ListBlox 
files and is the default option. 

Toolbar
The following tool buttons appear at the top of the Open dialog box:

Up One Level: Opens the folder one level higher than the current one.

Create New Folder: Creates a new folder in the current one.

List: Lists files and folders with their icons and names only.

Details: Lists files and folders with their icon, name, file size, file type, and date last modified.

Open button
Click to open the file specified in the File Name box. 

Cancel button
Click to close the dialog box without opening a file.



 Save As Dialog Box

Use the File | Save As command to save a ListBlox to a specified filename and location. The Save As 
dialog box presents the following options:

Save In
Identifies the current folder. The contents of that folder are listed in the box below. 

To view how the current folder fits in the hierarchy of folders on your computer, click the down arrow. To 
open one of those folders, simply click on it its contents are then shown in the list below.

Double-clicking on an existing file name in the list saves your ListBlox to that file, overwriting the current 
contents of the file.    

File Name
Use to specify a name for the file you want to save. You can specify a full path for the file if you wish. If 
you have selected a file in the list above, its name is automatically entered here.

Save as Type
Specifies the type of file you are saving. The list includes all file types that ListBlox supports. ListBlox 
Document (*.lbx) is the default option. 

Toolbar
The following tool buttons appear at the top of the dialog box:

Up One Level: Opens the folder one level higher than the current one.

Create New Folder: Creates a new folder in the current one.

List: Lists files and folders with their icons and names only.

Details: Lists files and folders with their icon, name, file size, file type, and date last modified.

Save button
Click to save your ListBlox to the specified filename and location. If you specify the name of an existing 
file, the current contents of that file will be overwritten. 

Cancel button
Click to close the dialog box without saving the file.



 Print Dialog Box

Use the File | Print command to print the current ListBlox. The following options allow you to specify how 
the document should be printed:

Printer
This section provides information about the currently selected printer.:

Name: Identifies the currently selected printer. To use a different printer, click on the down arrow and 
select a printer from the list displayed.

Properties: Use this to change the options for the currently selected printer. The options available depend 
on the type of printer it is.

Print to File: Prints the ListBlox to a file instead of to the printer. You are prompted for the filename and 
location.

Print Range
Use to specify whether you wish to print the entire ListBlox, a particular range of pages only, or the 
currently selected text only.

Copies
Number of Copies: Specify here the number of copies you want to print. 

Collate: If you are printing more than one copy, use this option to specify whether or not you want the 
copies to be collated.

OK button
Click to print the ListBlox.

Cancel button
Click to abandon the print job.



 Print Preview Dialog Box

Use the File | Print Preview command to display the current ListBlox as it would appear when printed. 
When you choose this command, the main ListBlox window is replaced with a print preview window in 
which one or two pages are displayed in their printed format. The print preview toolbar offers the following 
options:

Print Displays the Print dialog box so that you can send the 
ListBlox to print.

Next Page Preview the next page.

Prev Page Preview the previous page.

One Page/
Two Page

Preview one or two pages at a time.

Zoom In Zoom in to take a closer look at the page.

Zoom Out Zoom out to view the entire page(s).

Close Return from print preview to the main ListBlox window.



 Print Setup Dialog Box

Use the File | Print Setup command to change print settings.

Printer
This section provides information about the currently selected printer. 

To use a different printer, click the down arrow beside the Name box and select a printer from the list 
displayed.

To change the properties of the currently selected printer, click the Properties button. The options 
available depend on the type of printer it is.

Paper
Use to specify the paper size and source.

Orientation
Use to specify the paper orientation: Portrait or Landscape.

OK button
Click to implement any changed settings.

Cancel button
Click to abandon any changes you made.



 Insert New Object Dialog Box

Use the Edit | Insert New Object command to insert a new or existing object into a ListBlox. The object 
can be inserted as an icon or with its content displayed, and can be either linked or embedded. To 
activate and edit the object, simply double-click on it. 

The column where you insert a new object must have its data type defined as OLE item.

The Insert Object dialog box presents the following options:

Create New
Embeds a new object of the specified type into the current ListBlox. You specify the object type by 
selecting the appropriate option in the Object Type list.

Create from File
Embeds or links an existing file into the current ListBlox. You specify the file you want by typing its name 
in the File box. Alternatively, you can use the Browse button to browse through the files and folders on 
your computer until you find the file you want then double-click on it to enter its name automatically in the 
File box.

Select the Link option to specify that you want to link the file instead of embedding it. If you link the file, 
the copy of the file in your ListBlox is linked to the original source file and is updated whenever the source 
file is updated. If you embed the file, a separate copy is inserted in your ListBlox with no links to the 
source file. 

Display as Icon / Change Icon
Select Display as Icon to display the object in your ListBlox as an icon instead of with its content 
displayed. When you select this option, the default icon is displayed and also a Change Icon button which 
allows you to choose a different icon.

Result
Describes the result of using the current settings when you insert an object. 

OK button
Click OK to insert the specified object or file into your ListBlox using the currently selected settings. 

Cancel button
Click Cancel to close the dialog box without inserting an object.



 Convert Dialog Box

Use the Edit | Object | Convert command to convert a selected object to a different file type, to activate it 
using an application other than its original application, or to switch between displaying the object as an 
icon or as content. The Convert dialog box presents the following options: 

Current Type
Indicates the current file type.

Object Type
Lists the file types to which the object can be converted, or which it can be activated as.

Convert to
Click this to convert the object to the file type selected in the Object Type list.

Activate as
Click this if you want to edit the object using an application other than its original application. Select the 
required application in the Object Type list the selected application must support the particular object 
type. 

Result
Describes the result of implementing the current settings.

Display as Icon / Change Icon 
Select Display as Icon to display the object in your ListBlox as an icon instead of with its content 
displayed. When you select this option, the default icon is displayed and also a Change Icon button which 
allows you to choose a different icon.

OK button
Click OK to implement your selections. 

Cancel button
Click Cancel instead to close the dialog box without implementing your selections.



 Links Dialog Box

Use the Edit | Links command to list and edit any OLE links included in your ListBlox. Each link is listed 
with information on what type of document it is and its update status.

The Links dialog box presents the following options:

Source 
The location of the source is given.

Type
The type of the source document for example, an Excel worksheet or a Word document.

Update
Use to specify whether you want links to be updated automatically or manually (on request).

Update Now
Click this to update the currently selected link.

Open Source
Click this to open the source file for the currently selected link.

Change Source
Click this to specify a different source file for the currently selected link. 

Break Link
Click here to disconnect the currently selected link. This is useful if you no longer want changes in the 
source file to be reflected in your ListBlox.



 Font Dialog Box

Use the Font option in the Options dialog box to change the font attributes of ListBlox text.

Font
Lists all available fonts and indicates the currently selected one. To change to a different font, select the 
new font from the list.

Font Style and Size
Lists the available font styles and sizes for the currently selected font, and indicates the currently selected 
options. To change to a different style or size, select the desired options from the relevant list.

Effects
Use to specify whether the text should be struck out and/or underlined, and the color in which it should be 
displayed.

Sample
Displays sample text using the settings currently selected in the Font dialog box.

Color
Choose the color for the text. 

Script
Lists the available language scripts for the currently selected font, and enables you to select the one you 
want to use.

OK button
Click OK to implement any changes you have made. 

Cancel button
Click Cancel instead to close the dialog box without implementing the changes.



 Find Dialog Box
Use this dialog box to find a text string or value in ListBlox cells. 

Find What Enter here the text you want to find.

Find First Click here to find the first occurrence of the 
search term.

Find Next Click here to find the next occurrence of the 
search tern.

Cancel Click here to cancel the find operation.

More>> Click here to view the options listed below. This 
button then changes to <<Less.

Search In You can search in all records or in selected 
records only.

Direction From your current position in the ListBlox, you 
can search down or up through the cells.

Match Case Check this checkbox if you want items found to 
match the case of the search term. 

See Also
Finding Text in a Column



 Finding Text in a Column
To find text in a column, click on the Find icon above the column. You are then presented with a 
searchdown box where you can enter the first letter or letters of the text you are looking for.



 Sorting Entries
You can perform either a simple sort or a complex sort. A simple sort is one which is based on a single 
column. A complex sort is one where you can specify levels of sort orders. Typically, a secondary sort 
order comes into play when items in the primary column are the same.

Simple Sort

1 Select the column on which you want to sort.

2 Choose the Sort up arrow or Sort down arrow to sort in ascending or descending order 
respectively. Alternatively, choose Data | Sort Ascending or Data | Sort Descending from the Blox 
menu. The sort order is determined by the data type of the column.

Complex Sort

There are a number of ways in which you can perform a sort on multiple columns.

Choose Data | Sort from the Blox menu, and then specify the full details of the sort in the Sort 
Dialog Box.

Select the columns, and then choose Data | Sort Ascending or Data | Sort Descending. This takes 
the leftmost column as the primary column, the second leftmost as the secondary and so on.

Use the arrows on the Action bar
keep SHIRT or CTRL depressed while you click on the sort arrows. The first column you select is the 

primary column, the second is the secondary column and so on.
 



 Sort Dialog Box

Sort By Choose the column you want to use as the primary sort 
column, and specify whether you want the sort order to be 
ascending or descending.

Then By Choose the column you want to use as the secondary sort 
column, and specify whether you want the sort order to be 
ascending or descending.

Then By Choose the column you want to use as the tertiary sort 
column, and specify whether you want the sort order to be 
ascending or descending.

Choose OK to confirm your choice.



 Filtering Entries
A filter is a way of displaying certain types of entries in a ListBlox and masking the rest. Each column in a 
ListBlox has a filter icon in its heading. When you click on this, you see a list of all the unique entries in 
that column. Choose the entries you want to allow through the filter to select more than one entry, hold 
down Shift as you click.

To clear the filter, click on the Filter icon again, and select [Clear].
You can also set filters that operate across more than one column, and by default the combined filter is an 
AND filter in other words, the conditions set by both filters must apply. You may select only items that 
have not already been filtered out.
To set an OR filter (That is, one where either filter condition is met), hold down the CTRL key while you 
click on the Filter icon for the second column. 

To clear the filter for a single column, click on the Filter icon again, and select [Clear]. To clear a filter from 
all columns, right-click on any column heading, and choose Clear Filter from the menu.

Saving a Filter as a View



 Saving a Filter as a View
You can save filtered data as a view . 

1 While the view is displayed, click on the Manage Views icon.

2 Enter the name you want to call the view.

3 Choose Add to add the view to the available list of views.

Managing Views



 Managing Views Dialog Box
Click on the Manage Views icon to perform a range of functions relating to views.

The Views dialog box contains a list of previously-created views and offers you a range of options.

Apply Applies the currently selected view to the ListBlox.

Add To add a new view, enter its name and choose Add.

Remove Removes the currently selected view.

Close Closes the dialog box.



 Importing a List 

You can import a table from an ODBC-compliant application into ListBlox. 

1 Choose Import List from the File menu.

2 You are then shown a list of data sources from which to choose.

3 Once you choose the data source, you are asked to specify the table you want to import.



 Exporting a List

You can export a ListBlox to a table in an ODBC-compliant application.

1 Choose Export List from the File menu.

2 You are then shown a list of data sources from which to choose.

3 Once you choose the data source, you are asked to specify the ListBlox you want to export. 



 Data Sources Dialog Box

You can share data between ListBlox and ODBC-compliant applications. 

Importing a List

Select the data source from which you want to import a list and then click on OK. You are then presented 
with a list of tables from that source choose the one you want.

Exporting a List

Select the data source to which you want to export and then click OK by default the list has the same 
name in its new data source.

Exporting a List as

Select the data source to which you want to export and then click OK. You are then given the opportunity 
to give the data a new name in its new data source.



 Resizing Rows and Columns

You can resize rows and columns so that they accommodate your data better.

Rows: as you pass the cursor over the junction between two rows (in the row header column), it changes 
shape. Hold down the mouse button and drag the cursor down or up to increase or decrease the size of 
the rows.

Columns: as you pass the cursor over the junction between two columns (at the column heading row), it 
changes shape. Hold down the mouse button and drag the cursor right or left to increase or decrease the 
size of the columns.

Resizing All Rows/Columns

To resize all rows and columns to fit their contents, double-click between columns in the title bar. 



 Select Tables Dialog Box

The Select Tables dialog box lists tables in the data source you have specified at the SQL Data Sources 
dialog box. Select the table you want.



 Inserting Rows and Columns

Inserting Rows

To insert a row at the bottom of the ListBlox, place the mouse pointer at the bottom of the list and drag 
down. 

Inserting Columns

To insert a column to the right of the ListBlox, place the mouse pointer at the right edge of the list, and 
drag right. 



Microsoft Office Compatible

Microsoft Office Compatible

ListBlox is a Microsoft Office compatible product, which means that its toolbars, menus, and accelerator 
keys are similar to those used by Microsoft Office. If you are already using Microsoft Office, which 
includes Microsoft Excel, Word, Microsoft Access and Powerpoint, then many of the tasks you have 
learned to complete in Office can be completed in a similar manner in ListBlox. AlphaBlox and Microsoft 
hope these similarities will make it easier for you to use our products together and with other Microsoft 
Office Compatible products.

Look for the Microsoft Office Compatible logo when purchasing software. For more information about the 
Microsoft Office Compatible program, and for a complete listing of Microsoft Office Compatible products, 
in the United States, call Microsoft Customer Service at 1-800-426-9400. Customers outside the United 
States should contact their local Microsoft office. 

ListBlox and the Office Compatible Features

The skills that you have acquired while using Microsoft Office are applicable to ListBlox. You will find in 
ListBlox a menu and toolbar arrangement that is very similar to those of Office and the techniques you 
use for navigating around the application are the same. 

For example, to open a ListBlox, click on the Open button on the toolbar, and to save a ListBlox, click on 
the Save button. Of course, you can also use the Open and Save options on the File menu to achieve the 
same results. To discover the function of each button on the ListBlox toolbar, just position the mouse 
pointer over the button and the tooltip for that button is displayed.

OLE Enhancements
The ListBlox toolbar includes two buttons (Drag List and Drag Embed) that offer enhanced OLE 
functionality.

Use the Drag List button to embed the current ListBlox in a container document.

Use the Drag Link button to link the current ListBlox into a container document.

Toolbar Button Differences
Not all of the Office functions are placed on the toolbar.    The reason for this difference is that ListBlox is a 
compact product designed to fit into and complement your Office and other applications and so the 
toolbar has been kept to a minimum size, in order to keep the window width and height to the smallest 
and most useful dimensions.    The functions are, of course, all available from menus and shortcut keys.

In particular, you can access Cut, Copy and Paste via the Edit menu or by using the standard accelerator 
keys, these being Control X for Cut, Control C for Copy and Control V for Paste.

Using ListBlox with Microsoft Office

ListBlox incorporates full OLE functionality, and you can integrate it directly with Microsoft Office. For 
example,you might want to embed a price list into a quotation in a Word document; or you might want to 
link an action list into a Powerpoint presentation; or you might want to embed a list of suppliers' 
addresses into an Access invoicing database.

The are a number of ways in which you can integrate Office applications with ListBlox (and indeed other 
OfficeBlox applications). Some of the tasks that you can perform are described below.

Embedding a ListBlox in a Word Document
You can embed both new and existing ListBlox into a Word document.

To embed a new ListBlox in a Word document, open the document within which you want to place 
the ListBlox and from ToolBlox, drag ListBlox into position in the document.

To embed a previously created ListBlox, open it and then use the Drag List tool to drag it into 



position in the document. Once the ListBlox is in position in the document, double-click on it to activate it.

Linking a ListBlox to a Powerpoint Presentation
To link a ListBlox, open it and then use the Drag Link tool to drag it into position in the target document. 
For example, you could link detailed sales figures from a ListBlox into a Powerpoint presentation. 

Note: OLE works only with saved files, so you must save a ListBlox as a file before you can link it 
to an Office application.

Embedding and Linking Office Documents in a ListBlox
As well as embedding and linking ListBlox in Office documents, you can also embed and link Office 
documents in a ListBlox. For example, you could have a to-do list which required you to work on a range 
of Office documents, for example:

Monday Review latest sales 
figures

[Embedded Excel worksheet]

Tuesday Prepare presentation for 
board meeting

[Embedded Powerpoint 
presentation]

Wednesda
y

Write to JN [Embedded Word document]

In each case, you could embed (or link if you wish), an Office document into a ListBlox cell. Use the 
option Insert New Object from the Edit menu .

Before you embed OLE objects into ListBlox cells, make sure that the column where you want to place 
the documents has the property OLE type:

1 Select the column.

2 Right click and then choose Properties. 

3 Select OLE Item from the Data Type drop-down list.




